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Chapter 1
ODB++ Viewer

You can use ODB++ Viewer to examine the step of a product model that is stored in an
ODB++Design directory structure.
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ODB++ Viewer
Opening a Product Model Step

Opening a Product Model Step

You can open a step in an ODB++ directory structure that has been compressed into any of
these file types: tgz, gz Z, tar, or zip. You can view the graphic of the step and information
about each layer of the step.

When you first open ODB++ Viewer, you choose the step you want to view. Subsequently, you
can choose a different step to view, from within ODB++ Viewer.

The procedure for opening a product model step depends on whether you are working in direct
mode or in database mode.

e Direct mode — If your product models do not reside in a database, you can import each
product model into the ODB++ Viewer Product Model List and open a product model
step from the list.

e Database mode — Some Valor applications maintain a database where ODB++ product
models are cataloged. User access to these product models is managed by the
application. If your product models reside in such a database, ODB++ Viewer runs in
database mode, and the Product Model List dialog box lists the product models in the
database. You can open a product model that is cataloged in the database, or you can
import a product model from an ODB++ directory structure or compressed file into the
database, and then open it in ODB-++ Viewer.

When ODB++ Viewer opens in database mode, it requires a username and password
with rights to access the database. At some sites, the Valor application that maintains the
database has been set up to bypass the login screen and to provide a valid username and
password silently.

Opening the Stepin Direct Mode. . ......coiiitiiiiiiiiiiirenerennsennsannns

Opening the Step in Database Mode ...........cciitiiiiiiiiiiinrennrsnnnnnnns

Opening the Step in Direct Mode

You can open a step in a product model that resides in an ODB++ directory structure, or in an
ODB++ product model that has been compressed to one of these file types: tgz, gz, Z, tar, or zp.
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ODB++ Viewer
Opening the Step in Direct Mode

Procedure

1. Open the Product Model List dialog box.

If you want to...

Do the following:

Open ODB++
Viewer and open the
step

Open ODB++ Viewer in one of the following ways:

¢ From the desktop icon

e From the Windows Start menu

ODB ODB + + Viewer

App

Open a different step
in ODB++ Viewer

In ODB++ Viewer, choose File > Open Job.

The Product Model List dialog box opens.

B Product Model List

Product Maodel; I *

.y

Model Mame

[+ aspen_new
- unicam_pdw
- testcaseb
- job_pdif

i+ demo_design
‘. carcube_new

Remove

Import

Open

A

The list displays the locations of the ODB++ product models that have recently been
imported into ODB++ Viewer.

You can expand a product model node to list the steps of the product model.
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ODB++ Viewer
Opening the Step in Database Mode

By default, the Product Model List appears as a simple list of product models. Also
available is the “details” mode, which lists the product model names and full paths. You

can use the toggle button M to switch between the modes.

B | Product Model List >

Product Maodel; | * i=

Model Name Full Path
—Haspen_new | C/MentorGraphics/Valor/vMNPI_DIR/fw/jobs/aspen_new

aspen
panel
aspen+1
unicam_pdw  C/MentorGraphics/Valor/vMPI_DIRfw/jobs/unicar_pdw
testcased Cy/MentorGraphics/Valor/vMNPI_DIRfw/jobs/testcaset
job_pdif C/MentorGraphics/Valor/vMPI_DIRfw/jobs/job_pdif
+- demo_design C/MentorGraphics/Valor/vMNPI_DIR/fw/jobs/demo_design
carcube_new C/MentorGraphics/Valor/vMPI_DIRfw/jobs/carcube_new

Remove Import Open

To restrict the Product Model List, type a string in the Product Model field.
To import a product model into the Product Model List, click Import.

To remove a product model location from the Product Model List, select it and click
Remove.

2. In the Product Model List dialog box, double-click the product model or step you want
to open, or select the step and click Open.

Related Topics
Filtering the Product Model List
Importing ODB++Design Data

Opening the Step in Database Mode

If you are working in database mode, you can open a product model that resides in an ODB++
database. You can import a product model from disk into the database. Product models can be
imported from an ODB++ directory structure, or from one of these compressed file types: tgz,
gz Z, tar, or zip.
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ODB++ Viewer
Opening the Step in Database Mode

Procedure

1. Open the Product Model List dialog box.

If you want to...

Do the following:

Open ODB++
Viewer and open the
step

Open ODB++ Viewer in one of the following ways:
¢ From the desktop icon

e From the Windows Start menu

ODB ODB + + Viewer

App

When ODB++ Viewer opens in database mode, it requires a username
and password with rights to access the database. At some sites, the Valor
application that maintains the database has been set up to bypass the
login screen and to provide a valid username and password silently.

Open a different step
in ODB++ Viewer

In ODB++ Viewer, choose File > Open Job.

The Product Model List dialog box lists the product models in the database that was
specified during installation.

® | Product Model List >

Product Madel; | *

1]

Model Mame

+- aspen_new
unicam_pdw
testcaseb
job_pdif

+- demo_design
carcube_new

Impart Open

You can expand a product model node to list the steps of the product model.
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ODB++ Viewer
Filtering the Product Model List

By default, the Product Model List appears as a simple list of product models. Also
available is the “details” mode, which lists the product model names and full paths. You

can use the toggle button ﬂ to switch between the modes.

B | Product Model List >

Product Maodel; | * i=

Model Name Full Path
—Haspen_new | C/MentorGraphics/Valor/vMNPI_DIR/fw/jobs/aspen_new

.......... aspen
panel
aspen+1

unicam_pdw  C/MentorGraphics/Valor/vMPI_DIRfw/jobs/unicar_pdw
testcased Cy/MentorGraphics/Valor/vMNPI_DIRfw/jobs/testcaset
job_pdif C/MentorGraphics/Valor/vMPI_DIRfw/jobs/job_pdif

+- demo_design C/MentorGraphics/Valor/vMNPI_DIR/fw/jobs/demo_design

carcube_new C/MentorGraphics/Valor/vMPI_DIRfw/jobs/carcube_new

Import Open

To restrict the Product Model List, type a string in the Product Model field.
To import a product model into the database, click Import.

2. In the Product Model List dialog box, double-click the product model or step you want
to open, or select the step and click Open.

Related Topics

Filtering the Product Model List
Importing ODB++Design Data

Filtering the Product Model List

You can restrict the Product Model List to show only product models whose name contains a
constant string, or intervening characters at specific locations.
Prerequisites

You have opened the Product Model List dialog box as described in “Opening the Step in Direct
Mode” on page 6 or “Opening the Step in Database Mode” on page 8.
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ODB++ Viewer

Filtering the Product Model List

Procedure

Use the appropriate filtering option:

If you want to...

Do this:

List product models
containing a constant
string

Enter the constant string in the filter.

For example, entering the string demo lists product models whose

names include the string demo anywhere in the name.

m Product Model List

Product Maodel; | dema

1]

Model Mame

+- demo_design
demo_design+1
demonstration
panel_demo

Import

Open

List product models
whose names may
contain intervening
characters at specific
locations

Enter a string containing asterisks (*) to indicate where there may be

intervening characters.

For example, entering the string demo*1 lists product models with
names including the string demo, and then any intervening characters or
no intervening characters, and a one, anywhere in the name.

m Product Model List

ot

Product Madel: | demo®1

4

Model Mame

demuo
demo_design+1
demo_design
vsure_demol

Impart

Open

ODB++ Viewer User Guide, vNPI 2305
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ODB++ Viewer
Importing ODB++Design Data

If you want to... Do this:

List product models | Enter a string containing question marks (?) to indicate where there must
whose names contain | be intervening characters.

11;1terven1ng i For example, entering the string ?7demo?1 lists product models with
lc ar?cters atspecific | pames including the string demo, and then some intervening characters,
ocations

and a one, where the string demo is not at the beginning of the product
model name.

m Product Model List b4
Froduct Model: | 7demo?1 B
Model Mame

+- apd_dermo+1
create_panel_demo+1

Import Open

Importing ODB++Design Data

You can import an ODB++Design product model residing in an ODB++ directory structure or
compressed to one of the following file types: tgz, gz, Z, tar, zip.

Prerequisites
You have opened the Product Model List dialog box as described in “Opening a Product Model
Step” on page 6.
Procedure
1. In the Product Model List dialog box, click Import.
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ODB++ Viewer
Importing ODB++Design Data

2. Inthe Open File or Select Directory with “Accept Dir” dialog box, use one of these
options:

e To import a product model that resides in an ODB++ directory structure, browse to
the directory containing the ODB-++ structure and click Accept Dir.

[] Open File or Select Directory with "Accept Dir" ? >
Look in: I C:YjobsYjobs j @ (=} Q E] E
‘ My Computer Mame /| Size Type Date Modified i
L Fil..der 1/15/2018 1:45:10 PM
flows Fil..der 1/15/2018 1:45:10 PM
fonts Fil...der 3/7/2019 1:27:26 PM
forms Fil...der 1/15/2018 1:45:10 PM
input Fil..der 5/7/20191:27:26 PM
rnatrix Fil..der 5/7/2019 1:27:28 PM
misc Fil..der 5/7/2019 1:27:28 PM
output Fil..der 1/153/2018 1:43:12 PM
stackups Fil..der 1/15/2018 1:45:12 PM
steps Fil..der 5/7/20191:27:28 PM
curmhnle Fil rfder 182008 14520 PRA 2
J | Ll_l
File name: I Open
Files of type: I.ﬁ.II CDB++ input files (*.tgz *.gz *.Z *.tar *.zip) ll Cancel
Selected Directory: IC:,.’jnbs,.’jan Accept Dir
4
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ODB++ Viewer
Importing ODB++Design Data

e To import a product model that is compressed to a file, browse to the directory
containing the file, select the file, and click Open.

i

[+] Open File or Select Directory with "Accept Dir"

[t >

|

B demo_assytgz

741 KB tgz File

Look in: I C:Yjobs j (4= B B+ E] E
‘ My Computer Mame Size Type Date Modified
o My P yp
job& Fil..der 3/7/2019 1:27:44 PM

716/2018 &:16:02 PM

| L

File name: Idemn_assy.tgz

Open

Files of type: I.ﬁ.JI CDE++ input files (*.tgz *.0z *.Z *.tar *.zip)

ll Cancel

Selected Directory: IC:fjubs

Accept Dir

Results
The newly imported product model is added to the top of the Product Model List.
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ODB++ Viewer
ODB++ Viewer Window

ODB++ Viewer Window

You use the ODB++ Viewer to view the graphic of the product model step, and information
about the layers of the step.

Figure 1-1. ODB++ Viewer Window

m ODB++ Viewer [Job: demo_design; Step: rev_al — O >

File Actions View Help

=PAMuBAH|% r xR~ 1G>0 T |w

j| ODB++ Layer List | il
JOOOOOOOO00 L

sst

spt

sigt

. gig2 B

sig3

sigd
pgs

sig?

sig8 J

0 " -5011c04™

Signal sig2, E753 features, EDAL Layers = "signal 2", "signal™, "VIL"
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ODB++ Viewer

ODB++ Viewer Window
Objects
Table 1-1. ODB++ Viewer Window - Panes
Pane Description
ODB++ Layer List Used to choose layers to be displayed in the board

= ODB++ La}rerList| i‘
JOOO0O00000.. =
spt

sst
S -

viewer.

The color of the cell in the layer column (| =5 )
indicates the color in which the layer is displayed.

You can use the feature histogram or the component
histogram of a layer to highlight groups of entities in
the graphic area.

See “Using the Features Histogram to Select or
Highlight Features” and “Using the Components
Histogram to Select or Highlight Components™ in
Getting Started With ODB++ Design.

Board Viewer pane

Bl = 3.7485437", ¥ = 2.45232438"

Displays the graphic representation of the chosen
layers.

The X and Y coordinates of the current mouse pointer
position are displayed below the graphic.

Component Filter

B70 * PinMame: 1 -
@ RefDes () CPM O IPN
1 MPH 1 Package () wPackage 6 |CS

To display this pane, choose View > Component
Filter or click the Component Filter tool ( Cg'ﬁ).

See Using the Component Filter Pane to Find
Components” in Getting Started With
ODB++Design.

Overview pane

Use the Zoom area tool () to drag a rectangle in

this pane, or in the board viewer, to zoom to that area
in the board viewer.

16
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ODB++ Viewer
ODB++ Viewer Window

Table 1-1. ODB++ Viewer Window - Panes (cont.)

Pane

Description

Data bar

Highlighted: 119;

H=2.1leZ ¥=-Z_377

Part: 277 Pkg: TP3Z0 EOT 1 Pins

L=0.075 W=0_075% H=0 Rot=0.0 T= P=0

EOT #41 TP1lO0e

The data bar at the bottom of the window displays
information about highlighted features or
components.

When multiple features or components are
highlighted by double-click, the number of
highlighted features or components is prefixed to the
details of the first feature or component.

Table 1-2. ODB++ Viewer Window - File Menu Options

Tool File Menu Option | Description

- Open Job Opens the Product Model List dialog box so you
can open a product model whose steps you want
to view.

- Open Step Lists the steps of the current product model, so
you can open the step you want to view. This
option is unavailable if the product model has
only one step.

- Exit Exit the ODB++ Viewer.

Table 1-3. ODB++ Viewer Window - Actions Menu Options

Tool Actions Menu Description

Option

- View Orientation Open the “View Orientation” dialog box that
enables you to rotate, mirror, or flip the board
view.

oo Highlight Click the tool and click a feature to be

LT highlighted in the colors set for Highlighted and

o Highlight-2 shilg ghiig

X 1BHE Highlighted-2.

A symbol in the Color of features for each layer
column of the ODB++ Layer List indicates
whether one or two features are highlighted on
the layer.

=5  ODB++ Layer List
R 11100 00

ODB++ Viewer User Guide, vNPI 2305
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ODB++ Viewer
ODB++ Viewer Window

Table 1-3. ODB++ Viewer Window - Actions Menu Options (cont.)

Tool Actions Menu Description
Option
/% Highlight NET Open the Highlight CAD Nets dialog box in
which you can use two tabs to highlight CAD
nets in two different colors.
Choose a tab and select a CAD net to be
highlighted, or press Shift or Ctrl to select
multiple nets.
The legend lists the names of the selected nets
separated by semi-colons (;). The color in which
the selected nets are displayed is indicated.
E2 Highlight CAD Nets X
CADNet1  CADNet2 |
MET: .
$1N106 -
;'_1«11-3 & 29 :I
$1N107
$1N107_29
$1N1083
£1N103_29
$1N1133 -
[v CAD Net 1: $1N1644
v CAD Net 2: $1N107
[+ Show on viewed layers only
To view the features of the highlighted net on the
currently displayed layers only, select the option
“Show on viewed layers only”.
o Clear Highlighted Clear highlighting applied using Highlight or
Highlight-2.
s Measure Between Opens a sub-menu where you can choose
. Points whether to measure between points, features,
x| Measure Between nets, or annular rings.
£ Features See “Measuring Distances” in Getting Started
Eid Measure Between With ODB++Design.
Nets
Measure Annular
Rings
18 ODB++ Viewer User Guide, vNPI 2305
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ODB++ Viewer
ODB++ Viewer Window

Table 1-3. ODB++ Viewer Window - Actions Menu Options (cont.)

Tool Actions Menu Description
Option
i3 Snap Open the Snap dialog box in which you can

define snap and grid options.

Table 1-4. ODB++ Viewer Window - View Menu Options

View Menu Option

Description

Step & Repeat Table

See “Viewing the Step and Repeat Table” on
page 23.

Matrix

Opens the “Matrix” window displaying the layer
construction, layer types and subtypes, polarity,
drill intersection with board layers (for drilled via
holes), and sub-panel nesting.

Zoom In, Zoom Out

Zoom in or zoom out.

Zoom Area

Invoke the zoom area tool for drawing a zoom
rectangle in the board viewer or overview pane.

Zoom PopView

Display a magnified view of a section of the
board. You can open more than one popview
window at the same time. See “Zooming and
Panning” in Getting Started With
ODB++Design.

3

Zoom Home

Zoom to a view that fits the board in the graphic
area.

Previous Zoom

Returns to the zoom factor that was in effect
before the most recent zoom action.

Hl ®

Pan XY

Open the Pan XY dialog box.

B2 pan xy — O >

¥z |B.e4E1535 " ¥ - 3. 0G51é&811

Goto |

Type the X and Y coordinates to be brought to
the center of the graphic area and click Goto.

el

Pan Left, Pan Right,
Pan Up, Pan Down

Pan left, right, up, or down.
(shortcuts: keyboard arrow keys).

ODB++ Viewer User Guide, vNPI 2305
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ODB++ Viewer
ODB++ Viewer Window

Table 1-4. ODB++ Viewer Window - View Menu Options (cont.)

Tool View Menu Option | Description
0 View Properties Open the “Component Information” or “Feature
Information” dialog box to view detailed
information about the selected item.
je Component Filter Open the component filter pane. See “Using the
Component Filter Pane to Find Components” in
Getting Started With ODB+ + Design.
| Color Settings Open the “Colors” dialog box that enables you to
set colors for displaying items in the graphic area.
- Component Options | Open the “Component Display Options” dialog
box that enables you to configure some aspects of
how components are displayed in component
layers.
- Show Populated Toggle between showing all components and
Components Only / | showing only populated components.
Show All
Components
- Control Open the “Control” dialog box that enables you
to control the display of data in the graphic area.
Table 1-5. ODB++ Viewer Window - Help Menu Options
Tool View Menu Option | Description
- View Help Opens documentation for the ODB++ Viewer.
(shortcut: F1)
- About Displays ODB++ Viewer version and system

information.

Table 1-6. ODB++ Viewer Window - Board Viewer Right-Click Menu Options

Option Description

Zoom area Invokes the zoom area tool so you can drag a zoom rectangle in the
board viewer pane or overview pane.
Equivalent to clicking the Zoom Area ([]) tool.

Popview Display a magnified view of a section of the board. You can open more
than one popview window at the same time. See “Zooming and
Panning” in Getting Started With ODB++ Design.
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ODB++ Viewer
ODB++ Viewer Window

Table 1-6. ODB++ Viewer Window - Board Viewer Right-Click Menu Options

Option

Description

Measure

Invokes the measure tool so you can measure the distance between two
points.

Equivalent to clicking the Measure ( i ) tool.
See “Measuring Distances” in Getting Started With ODB++ Design.

Highlight

Invokes the highlight tool so you can highlight a feature or component.

Equivalent to clicking the Highlight a feature or a component (s3)
tool.

Clear highlighted

Clears all highlighted features and components.
Equivalent to clicking the Clear Highlighted (%) tool.

Toggle pile-up
selection

Overlapping features make it difficult to choose an individual feature
from among them. Pile-up selection mode provides a list of overlapping
features that are at the board location at which you clicked, from which
you can choose the feature you want.

;

Select All
TOP =845, Ril

TOR #3846, RT5
TOP, #1715, XUL

(.

Table 1-7. ODB++ Viewer Window - Board Viewer Shortcuts

Shortcut Description

Ctrl+a Invokes the Zoom area tool for one actuation. After you have dragged a
rectangle in the board viewer pane or in the overview pane, the tool that
was previously in effect is in effect.

Ctrl+d Pan down with 90% overlap.

down arrow

Ctrl+e Click on the board graphic and press Ctrl+e to pan the board viewer pane
to center that point in the pane.

Ctrl+h Zooms to a view that fits the entire board in the graphic area.

Ctrl+Home

Ctrl+i Zooms in. Equivalent to clicking the Zoom In tool ( & ).

Page Up
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ODB++ Viewer
ODB++ Viewer Window

Table 1-7. ODB++ Viewer Window - Board Viewer Shortcuts (cont.)

Shortcut Description

Ctrl+l Pan left with 90% overlap.

left arrow

Ctrl+m Toggles between a four layer display and more than four layers.
Ctrl+o Zooms out. Equivalent to clicking the Zoom Out tool ( & ©).
Page Down

Ctrl+r Pan right with 90% overlap.

right arrow

Ctrl+Shift+d Pan down with 10% overlap.

Shift+down arrow

Ctrl+Shift+] Pan left with 10% overlap.

Shift+left arrow

Ctrl+Shift+r Pan right with 10% overlap.

Shift+right arrow

Ctrl+Shift+Space Returns to the zoomed display in memory after zooming other areas.
Ctrl+Shift+u Pan up with 10% overlap.

Shift+up arrow

Ctrl+Space Copies the current zoomed display to memory.

Ctrl+u Pan up with 90% overlap.

up arrow

Ctrl+w Toggles the view of features among these modes:

full J , outline
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Table 1-7. ODB++ Viewer Window - Board Viewer Shortcuts (cont.)

Shortcut

Description

middle-click

The middle button can be used for these pan and zoom functions:

e Center in Graphic Area — Middle-click a point in the graphic area.
The click point is panned to the center of the graphic area.

e Zoom Out — With the middle button, drag a diagonal up and to the
right, ending at the point you want in the center of the graphic area.

e Zoom In — With the middle button, drag a diagonal down and to the
left, ending at the point you want in the center of the graphic area.

e Zoom to Area — With the middle button, drag a diagonal down and
to the right, so that the start and end of the line you drag define a
rectangular area to which you want to zoom.

e Zoom Home — With the middle button, drag a diagonal up and to
the left. The view zooms so that the whole board is displayed
centered in the graphic area.

Shift+Home

Zooms to a view that fits the highlighted component in the board area.

Equivalent to clicking the Zoom Home tool ().

Usage Notes

e (lick one or more layers in the ODB++ Layer List to display them in the board viewer.

e To use the board viewer shortcuts, you must place the mouse pointer in the board viewer

pane.

e Click the Toggle Units tool (,1,]) on the toolbar to toggle the measurement units

displayed in the X and Y coordinates under the board viewer, and for the Measure tool,
between inches and mm.

Viewing the Step and Repeat Table

If your product model contains step and repeat data, you can view panelization information in
the Step & Repeat Table dialog box.
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Procedure
1. Choose View > Step & Repeat Table.
o8 Step & Repeat Table E|E| [X|
Step Anichor Point Nzx N+ D (" Dy (" ) Angle Flip

[12 ][n_uunnnn ,0.000000 ] |1 | |4 | ||:|_|:u:u:u:u:u:| | ||:|_|:u:u:u:u:u:| | |2?|:| v|

’pch “D_DDDDDD ,0.000000 ] |1 | |4 | ||:|_|:u:u:u:u:u:| | ||:|_|:u:u:u:u:u:| | |9|:| v|

[I-Iew step :”EI.EIEIEIIZIEIEI ,0.000000 ] |1 | |1 | |D_DDDDDD ||D.DDDDDD | ||:| v|

[ Close ]

2. View the panelization information in the table:

Column Description
Step Name of the step.
Anchor Point Anchor point of the step.
Nx, Ny Number of steps in the X and Y directions.
Dx, Dy Distance between steps in the X and Y directions, in the indicated units
of measure.
Angle Rotation angle for the step inside the panel.
Flip Indication of whether the step is flipped about the Y-axis.
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Troubleshooting
If the ODB++ Viewer does not run as expected, review the suggested troubleshooting topics.
Cannot Open ODB++Design Archive File on Windows 7 ............. ...t 25
ODB++ Viewer on Linux 64 Bit Fails to Open a Product Model .................. 26
Entry Point Errors Due to Wrong DLL Usage...........ciiiiiiiiiiinnnenenns 26

Cannot Open ODB++Design Archive File on
Windows 7

If you cannot open a tgz file in ODB++ Viewer, this is most likely caused by incorrectly set
permissions with the database. This problem can also affect your vendors and make the files
unusable to them as well.

Symptoms

When attempting to open a tgz file, Windows 7 displays this error message:
ERROR: gen txt-6003-Unable to open file

Causes

Incorrect permission settings in Windows 7.

Solution

To correct the permission problems with the database, perform these steps:

1. In Windows Explorer, right-click the directory where your design resides and choose
Properties.

2. Click the Security tab.

3. Click Edit.

4. Add Write privileges to the appropriate users. In this case, Everyone.

Note
This procedure provides only a temporary fix for the tgz file you are attempting to open. As

a long-term solution, your IT department must ensure that permissions are set correctly for
everyone.
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ODB++ Viewer on Linux 64 Bit Fails to Open a
Product Model

If the ODB++ Viewer fails to open a product model (job), this is most likely due to
compatibility issues between Valor NPI and the 64-bit Linux operating system.

Symptoms

The attempt to open a product model (job) fails. The Linux console log may display an error
message. For example:

gunzip: stdin: invalid compressed data--crc error

Causes

The compress and expand utilities provided with the Valor NPI installation are incompatible
with the 64-bit Linux system.

Solution
Enter the following command to install the 32-bit library:

yum install glibc.i686
If the problem persists, replace the gunzip, gzip, and compress files in the Valor NPI installation
directory with their official versions available on your machine. Enter these commands:

cp /bin/gunzip <vNPI installation EDIR>/misc/

cp /bin/gzip <VvNPI installation EDIR>/misc/

cp /bin/compress <VvNPI installation EDIR>/misc/

Where <VNPI installation EDIR> is the path to your Valor NPI installation directory.

Entry Point Errors Due to Wrong DLL Usage

After successful install of ODB++ Viewer, you may receive Entry Point Not Found errors when
trying to run the program.
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Symptoms

Examples of Entry Point Not Found error messages:

f The procedure entry point

@’ Tendl@Qt@@YAAEAVOTextStream @ @AEAVZE@Z could not be
located in the dynamic link library
ChAMentorGraphics\Valor\ODB + +_Viewer\odbviewer_cvers\edirinvidep
shwalor_gt_514\ib\QtSXmldil.

-OK |

f The procedure entry point

@ TtabletEvent@QWidget @ @MEAAXPEAVOTabletEvent @@ @Z could
not be located in the dynamic link ibrary
CimentorGraphics\Valor\ODEB + +_Viewerodbviewer_cvers\ edirfimadilsy,
QO DBEViewerwingd.opt.Vsure.dil.

oK I

Causes

External QT DLLs are found in the C:\Windows\System32 location, which always has the
highest PATH priority. As a result, the wrong DLL files are loaded when the software is started.
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Solution

Place the QT files supplied with the installation next to the main executable:

1. Copy all the files from:

.Jodbveiwer_<ver>/edir/nv/deps/valor_gt_514/lib

Clipboard Organize New 9
+ o odbviewer_oes edir 5 ov » o deps ¢ ovalor gt 514 » b wo !
a O Hame Date modified
CCBSE )
i CtSConedil
] -
3 Gt BG4l
oads X | CtShutievedia. il
et ’ 1 CtSetwarkdil M
] o 5 CHSPrintSuppornt.dil B
y CitShvg.dil PM
Struchure CtSWidgets.dil 'l
2 Y CSenldll P
amples

2. Paste the copied files to:

.Jodbveiwer_<ver>/get

Drganize

v ODBes_Viewer oo v odbviewer e v edir &

A ] Mame

imageformats
] adtviewerexe

ol & CH5Cone.dil
- | CHSG.dll
= CtShuttimedia.dll
- Ot SMetwor.dll
] OHSPrHmtSuppertdll
|4 Cssvg.an
4 CtSWidgets.di
| CtSiml.di

get

| ODBViewsr.winid.opt. GenLowLevel il

MHew

SO0 T 15 Fi
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